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  Subject 
Topics Total 

Duration Theory Practical 
Sem - I         

A04-01 
Internet Fundamentals & E-
Business, SEO, Payment 
Gateway Steps. 

Basics of Internet 
Concepts, E-Commerce 
Framework, E-Commerce 
Security Issue, 
Introduction to WAP. SEO, 
Payment Gateway Steps. 

20 20 -- 

A04-02 
E-Web Publishing & 
Scripting (Client Side 
Scripting) 

HTML using Frontpage, 
DHTML, Introduction to 
XML Scripting Using Java 
/ VB 

100 40 60 

A04-03 Web Graphics & Multimedia 
Development 

Adobe Photoshop & 
CorelDraw 60 20 40 

A04-04 Networking & 
Communication Technology 

Networking Basics, 
Installing & Configuring the 
Network with Win 
2003/2008 
Server Administration 
tools 

100 60 40 

 Total (Hrs)  280 140 140 
Sem - II      
A04-05 RDBMS RDBMS using MySQL 100 45 55 

A04-06 Application Programming Programming using 
C#.net 100 40 60 

A04-07 

Web Application 
Development using Java 
Programming (Server Side 
Scripting) 

Basics of OOPs concepts 
& C++, Core Java 
programming using J2EE 
Framework, Java Applets 
& Swings, JDBC, Java 
Servlets, Java Beans, 
Introduction to JSP, EJB 

100 40 60 

A04-08 Project Work 

Using Web / Application 
Development with Case 
Study on Payment 
Gateway 

20 - 20 

  Total (Hrs)  320 125             195  
 

 
  



Module Code: A04- 01 
Module Name: Internet Fundamentals and E-Business 
Topics- Basics of Internet Concepts, E-Commerce Framework-Commerce Security Issue, 

Introduction to WAP           

                          Theory-20 

INTERNET 

What is Internet: How does it work. 

What you can do in Internet: Send E-mail, subscribe to news group or mailing list, on line shopping 
Access to huge amount of data stored on computers that make up the Internet. 

Getting Connected: What is needed to get connected Modem, Account with ISP, Internet service 
Provider. 

What is ISDN: Integrated services Digital Network? 

What is Modem: How it works, three types of modems: External Card Modem, Internal Modem, U.S. 
Robotics etc.: Baud rate: Internal, External, SENDING & RECEIVING E-Mail: What is E-mail? How to 
decipher an E-mail address, How to send e-mail, Attaching a document: receiving e-mail, storing e-
mail addresses, DOWNLOADING files, Files type: Image files: jpg, gif, tif, bmp., ped:Audio: com, 
exe, bat, compressed files and text files. World Wide Web WWW: What is WWW: Web Pages: Can 
be used for: Commercial Activity, Research, Personal Interest: Web Browsers: NetScape, IE. 

WAP 

INTRODUCING WAP: - What is WAP, Importance & Benefits of WAP, History of WAP, WAP 
Architecture, WAP Services, Why WAP, Future of WAP. 

BASICS OF A GOOD WAP APPLICATION: - WAP Micro browsers, Generic WML Interface, 
Application design process, common design mistakes. 

THE USER INTERFACE:- User interface basics, Low bandwidth, Small Screen size, Text Entry, 
Using the Cache, Types of WML cards, The Back button. 

WAP DEVELOPMENT TOOLS & SOFTWARE: Editors & emulators, Software Developer Kits and 
Integrated Development Environments, Converting Images, Specification of Well defined WBMP 
types. DATABASE DRIVEN WAP:- Active Server Pages, ASP & WAP, The ASP Object Model, 
Activex Objects, Physically Connecting To Database, Querying The Database, Using The Returned 
Data, Tidying Up. 

E-COMMERCE 

Basics: Defining E-commerce, Essential Elements of E-commerce, Significance in Modern Business, 
Relationship between EDI & E-Commerce, Important Principles of E-Commerce, Future of E-
Commerce, Mobile Commerce.  



E-Business: What is E-Business? Fundamental of E-Business, How to Start E- Business? Rules of: 
E-Business Netiquette, Formulation of E- Business, How to Start E-Business Strategy, Uses.  

E-Commerce Terminologies E-mailing & E-Commerce: Concept of E-mail, How it promotes the 
business?  

Electronics Payment System: What is Electronics Payment System? Features, Cash-Like Payment 
Systems, Cheque-Like Payment Systems, which Electronic Payment System is best? Major Issues in 
Electronics Payment Systems.  

Electronic Data Interchange (EDI): What is EDI? Origin of EDI, Who Uses EDI? How EDI Works? 
How to use EDI. Comparing EDI & Internet, How Does EDI differ from Traditional Purchasing 
methods? What are EDI Standard Formats? How we successfully Implement EDI in our Company? 
One can use Internet & WWW for EDI, VAN & EDI.  

Search Engine Optimization(SEO) -What is SEO, Need of SEO,How search engine 
operates(crawling and indexing), Interaction with search engines,Search engine marketing,keyword 
research,link signals,effect of usability and content on search engine ranking,search engine 
protocols,metrics for SEO 

Payment Gateway-Payment Gateway in e-commerce,Woking of Payment Gateway,Payment 
Gateway, integration, payment processor vs Payment Gateway, Examples of Payment Gateways in 
India 

WWW & E-Commerce: Importance of a Domain Name, Features of a Good Domain Name, What is 
a Domain Name? What makes a Good Domain Name? Benefits of having your own Domain name, 
Guide for Setting, Profitable Web Site, How to Sell your Products on the web? 

  



Module Code: A04- 02 
Module Name: E-Web Publishing & Scripting (Client Side Scripting) 

Topics- HTML using Frontpage, DHTML, Introduction to XML Scripting Using Java / VB 

 
Theory-40 
Practical -60 

HTML 

Document Formatting system-HTML elements-Tag rules-Basic HTML elements (Address element, 
Anchor element, Base element, Block quote element, Bold face and Italics element, Cite element, 
code element, List and Term element, Direction element. 
Emphasis element, Heading element, Image element, IsIndex element, keyboard element, Line-
Break element, Link element, MENU element, Meta-Information element, Paragraph element, 
Preformatted element, Rule element, Sample element, Strong element, HMP and  Listing elements, 
Tele Type element – Characters, words and paragraphs – Fragment Identifiers – HTML forms – 
Forms element – Form data gathering (INPUT CHECKBOX, INPUT IMAGE, INPUT PASSWORD, 
INPUT RADIO, INPUT, RESET, SELECT, INPUT SUBMIT, TEXT AREA) – Public Text Identifiers 
(Address, Applet, Area, Base, Big, Body, Caption, Center, Cite, Code, DD, DL, DT, DFN, DIR, DIV, 
EM. FONT, FORM, HI through H6 head, HR, IMG, INPUT, ISINDEX, KBD, L1, LINK, MAP, MENU, 
META, OL, OPTION, PARAM, PRE, SAMP, SCRIPT, SELECT, SMALL, STRIKE, STRONG, STYLE, 
SUB, SUP, TABLE, TD, TEXT, AREA, TEXT FLOW, TH AND TD, TITLE, TR, TT and UL  elements) 
– Attributes (ACTION, ALIGN, ALINK, BACKGROUND, COMPACT, ENCTYPE, FACE, HEIGHT, 
HREF, EQUIV, MAXLENGTH, METHOD, MULTIPLE, NAME, NOSHADE, PROMPT, REL, REV, 
ROWS, ROWSPAN, SELECTED, SIZE, SRC, TEXT, TITLE, TYPE, USEMAP, href:\ 
DHTML 
DHTML AND STYLE SHEETS: Defining Styles; Elements of Style; Linking a Style Sheet to an HTML 
Document; In-line Styles; External Style Sheets; Internal Style Sheets; Multiple Styles. 
XML 
XML Basics: The History Of XML;The Origins Of XML; Comparison Of XML And Html, Components 
of XML; 
Anatomy Of An XML Document : A Sample XML Document; XML Declaration; The Root Element; An 
Empty Element; Attributes, Markup Delimiters; Element Mark Up; Attribute Mark Up; Naming Rules; 
Character References;  Predefined Entities; Entity References; Cdata Sections; Processing 
Instructions. 
Creating  Welformed  And Valid Documents : XML And Structured Information; Document Type 
Declaration ; Welformed And Valid Document; DTD  And Validation; Internal DTD Subset ;External 
DTD; Developing The DTD ; Elements And Attributes Of DTDs; More About Elements; Empty 
Element; Element-Only Element; Mixed Elements; Any Element; More About Attributes; String 
Attributes; Enumerated  Attributes; Tokenised Attributes; Creating A Valid Document From A DTD; 
 
Styling XML with CSS: Cascading Style Sheet, XML, CSS And Web Browsers; Specifying CSS 
Properties; Classes; Id Attributes; Embedding CSS In XML 
 
Rendering XML with XSL: Comparing XSL And CSS; Template Rules; The Default Template Rules; 
Formatting  Objects; Layout Formatting Objects And Content Formatting Objects; Exploring XSL Style 
Sheets; Xslt Template Constructs 



VB SCRIPT 
Difference between Visual Basic and VB Script, Adding Script to Documents, Working with Numbers, 
Strings, Date & Time and Arrays, If. Then Else, loops, select case, Error Trapping, Getting message 
across, Confirming user action, Working with scripts, working with documents, Working with forms, 
Validation of data (text, numbers, date), Validate list selections, Multimedia Techniques: Creating and 
displaying graphic images, loading graphics in background, Displaying a Marquee Text, Playing 
Audio/Video files.  
JAVA SCRIPT  
JAVA Script variables, Operators, Text input, reserved words, constructors, functions, objects, events 
and Interact with forms - [Displaying moving graphics -Display graphics files, Arrays- Vectors- 
generating color-JAVA Soft-JAVA Report-JAVA Newsgroup]-Control Structures: If expression, Switch 
statement, For loop, while loop, Do loop, Continue and Break Statements, some graphics library-
Multitasking Applets -Passing parameters to your applet-Basic Abstract Windows toolkit (AWT)-
Protecting Classes and methods-Modifiers, Class Security and Packages, Excepts-Threads - 
Applications, File-Handling and Data Structures.  
  



Module Code: A04- 03 
Module Name: Web Graphics & Multimedia Development 

Topics- Adobe Photo shop and CorelDraw                                            
  Theory - 20  

                                                                                                                    Practical-40 
              
              
           
DESK TOP PUBLISHING TOOLS: 
ADOBE PHOTOSHOP 

 The Basics-  New Page; The Toolbox (Selection Tools; Painting Tools; Path, Type and Shape  Tools,  
Viewing Tools); Tool Options Bar; What’s on the  Menus (File and Edit Menu, The Image Menu, The 
Layer  Menu, The Select Menu, The Filter Menu, The View Menu, The Window Menu, The Help 
Menu); Setting Preferences. 

 Opening and Saving- Working with Files (Opening Files, Using the Browser, Importing a File); Saving 
Your Work (Reducing File Size, Choosing a Format); Undoing and Redoing. 

 Selection Modes:  The Selection Tools (Rectangular  and Elliptical Marquees, Lasso, The Polygonal 
Lasso Tool, The Magnetic Lasso, Magic Wand); The Selection Menu (Feather, Modifying  
Selections); Selecting Large Areas; Cutting the  Copying; Cropping. 

 Transformations: Resizing  (Resizing an Image, Resizing a Canvas, Resizing a Selection); Rotating 
(Rotate  180 Degrees and 90 Degrees  Clockwise or  Counterclockwise, Rotate by Degrees, Rotate  
a Selection, Free  Transformations); Flipping; Selection Transformations (Skewing Selections, 
Distorting Selections, Changing the Perspective of  a  Selection). 

 Color Modes and Color Models: Color Models (RGB Model, CMYK Model); The Modes and Models of  
Color (Bitmap  and  Grayscale, RGB, CMYK, Converting  between Modes. 

 Adjusting Color: Adjusting by Eye with Variations (Adjusting Shadows, Midtones, Highlights, and 
Saturation, Saving and Loading Corrections); Making other Adjustments (Adjusting with the 
Brightness/Contrast Dialog Box, Adjusting with the Hue/Saturation Dialog Box, Adjusting with the 
Curves Dialog Box, Adjusting with the Levels Dialog Box); Adjustment Layers. 

 Paintbrushes and Art Tools: The Brushes Palette (Brush Options Dialog Box, Brush Options); 
Brushes (The Air Brush, The Brush, The History Brush, The Art History Brush, The Eraser, The 
Pencil). 

 Digital Painting:  Foreground and Background Colors; Selecting Colors (The Color Picker, The Color 
Palette, The Swatches Palette, The Eyedropper Tool); The Blending Modes. 

 Moving Paint: The Smudges (Using the Smudge Tool, Setting Smudge Options); Focus Tools (The 
Blur Tool, The  Sharpen Tool); The Toning Tools (Dodge and Burn Tools, Sponging);  

 Advanced Painting Techniques: Simulating Different Media (Watercolors, Pencil and Colored Pencil, 
Chalk and Charcoals). 

 Layers : Using the Layer Palette (Reordering Layers, Hiding and Showing Layers, Removing Layers); 
Working with Multiple Layers (Opacity, Layer Blending Modes, Linking Layers, Layers Sets, Merging 
Layers, Transferring Layered Images to Image Ready, Layer Effects). 

 Using Masks:  Applying Masks, Using Quick Masks, Layer Masks (Editing Layer Masks, Removing 
the Layer Masks, Making Layer Masks visible with Channels). 

 Paths: Creating Paths (Paths via Selection, Path via Pen Tool); Editing Paths (The Path Tools, The 
Basic Path Techniques); Using Paths (Turning Paths into Selection, Filling a Path, Stroking a Path, 
Using the Vector Mask Tools). 



 Filters that Improve Your Picture: Sharpen Filters (Sharpen, Sharpen More, Sharpen Edges, Unsharp 
Mask); Blur Filter (Blur, Blur More, Gaussian Blur, Radial Blur, Smart Blur, Motion Blur); Fading 
Filters. 

 Filters to Make Your Picture Artistic : Artistic Filters (Colored Pencil, Cutout, Dry Brush, Film Grain, 
Fresco, Neon Glow, Paint Daubs, Palette Knife and Plastic Wrap, Poster Edges, Rough Pastels, 
Smudge Stick, Sponge, Under Painting, Watercolor); Brush Strokes (Accented Edges, Angled 
Strokes and Crosshatch, Dark Strokes, Ink Outlines, spatter, Sprayed Strokes, Sumi-e); Sketch 
Filters (Bas Relief, Chalk and Charcoal, Charcoal, Chrome, Conte  Crayon, Graphic Pen and Halftone 
Pattern, Note Subject Code and  Plaster, Photocopy, Reticulation, Stamp and  Torn Edges, Water 
Subject Code). 

 Filters to Distort and Other Funky Effects: Distort Filters (Diffuse Glow, Displace, Glass and Ocean 
Ripple, Pinch, Spherize, and ZigZag, Sheer, Twirl); Pixelate Filters (Crystallize, Pointillism and 
Mosaic); Stylize (find Edges, Glowing Edges and Trace Contour, Wind, Emboss); Combining Filters 
(Texturizer, Rough Pastels and Film Grain). 

 Adding Type to Pictures: The Type Tools (The Character Palette, The Paragraph Palette); Setting 
Type; Creating Drop Shadows (Variation: Shadows on Backgrounds); Cutting and Filling Type; 
Adding Glows; Creating Bevel and Emboss Effects (Metallic Type); Warping Text; Checking your 
Spelling Special Effects and Useful Tricks: Glows; Lighting Effects; Reflections; Extracting Selections; 
Notepad; Contact Sheets and Picture Packages (Contact Sheets, Picture Packages); Working 
Efficiently (Tool Presets) Photoshop Plug-Ins and Add-Ons : Where to get plug-Ins; How to Install  
Plug-Ins; Alien Skin’s Eye  Candy (Splat); Genuine Fractals; Andromeda. 

 Compositing: Sources for Images; Making One Picture from Two; Realistic Composites, Replacing a 
Background; Composites from Nothing. 

 Photo Repair – Black and  White: Easy Fixes; Using the Eye-Dropper; Using the Clone Stamp; 
Healing  Brush and Patch Tools; Cleaning Up a Picture Step by Step; Applying Tints (Dutones, Hand-
Tinted Photos); Vignetting. 

 Photo Repair – Color: Color Retouching (Fixing Red Eye, Drag and Drop Repairs, Editing a Picture); 
Removing (Putting back What Was Never There). 

 Printing: Choosing a Printer (Inkjet Printers, Laser Printers, Dye-Sublimation Printers, Thermal Wax 
Printers, Image setters); Preparing to Print; Printing the Page; Preparing the Image  (Working 
Spaces, Color Management Policies, Conversion Options); Subject Codes. 

 Photoshop for the  Web : Jumping into Image Ready;  File Formats and File Size (JPEG (Joint 
Photographic Expert’s Group), GIF (Graphics Interchange Format), PNG (Portable Network 
Graphics)); Preparing Backgrounds; Building Animations; Web Photo Gallery; Creating Slices; 
Creating a Rollover Effect; Preparing  Text for the Web; Making Pages Load Faster. 
 
 
CORELDRAW 
 

 Introduction: Brief history, Features of CorelDraw, CorelDraw Graphics suite, Corel Draw versions, 
minimum system requirements 

 Opening CorelDraw-,Exploring CorelDraw window, Corel Draw menus, setting up the page, Moving 
Around the Current Page, Viewing Modes, Inserting and Deleting Pages, Changing Page 

 Customizing Options-Using Multiple Workspaces, Customizing the Toolbars, Using Shortcuts, 
Saving Defaults, Setting File Backups 

 Object Creation And Manipulation-Drawing and Shaping Tools, Using the Freehand Tool, Drawing 
Lines and Polylines, Drawing Freehand Polygons, Drawing Perfect Shapes, Reshaping Lines and 
Polylines, Drawing Curves, Reshaping Curves, Drawing Rectangles, Drawing Circles 

 Selecting & Manipulating Objects-Selecting and Deselecting Objects, Moving Objects, Copying 
and Deleting Objects, Deleting Objects, Sizing Objects 



 Transforming Objects-Mirroring Objects, Rotating and Skewing Objects, Using Transform Docker 
 Outlining & Filling Objects- Eyedropper and Paint bucket Tools, The Outline Tool, Choosing Outline 

Thickness, Choosing Outline Color, Using Fill Tool, Uniform Fill, Fountain Fill, Pattern Fill, Interactive 
Mesh fili, Copying Attributes, Setting Outline and Fill Defaults 

 Arranging Objects-Arranging Objects, Grouping and Ungrouping Objects, Using Guidelines, Using 
Dynamic Guides, Using Snap To, Aligning Objects, Group and Child Objects, Combining and 
Breaking Objects, Welding Objects, Using Intersection, Using Trim 

 Using Layers- About Layers, Editing Layers, Setting Up a Master Layer, Moving, Copying, and 
Locking Layers, Reordering Layers, Using the Object Manager 

 Special Effects-Drawing With the Artistic Media Tool, Shaping an Object with an Envelope, 
Extruding an Object, Blending Two Objects, Using the Lens Effect, Adding Perspectives, Using 
Power Clips, Applying Contours, Applying Drop Shadows, Using Interactive Fills, Applying 
Distortions, Using Interactive Transparencies, Applying Mesh Fills 

 Working with Text-The Text Tool, Creating Artistic Text, Editing Text, Formatting Text, Setting Text 
Options, Creating Paragraph Text, Choosing Paragraph Options, Setting Indents Using the Ruler, 
Importing Text, Using the Spell Checker, Importing and Sizing Paragraph Text, Flowing Text Between 
Frame, Formatting Paragraph Frames, Wrapping Paragraph Text Around Objects, Applying Drop 
Caps, Typing Text Into Objects 

 Special Text Effects-Fitting Text to a Path, Converting Text to Curves, Creating Blended Text 
Shadows, Jumpy Text, Neon Text, Glowing Text, Chrome Text, Bevel Text, Creating Enveloped Text 

 Playing with colors-Text Implementing Color Management, Creating Custom Color Palettes, 
Choosing a Color Using Color Harmonies, Applying Colors Using the Color Docker, Automatically 
Creating Color Styles, mixing of colors 

 Using Symbols and Clipart-Inserting Text Symbols, Adding Clipart, Modifying Clipart 
 Working With Bitmaps-What is a Bitmap, Importing Bitmap Options, Adjusting Color, Hiding Certain 

Colors in a Bitmap, Applying Special Bitmap Effects, Creating Web Images, Advanced GIF Options 
 Special Page Layouts-Creating a Greeting Card, Print Previewing the Layout, Creating Labels 
 Printing-Print Options, Print Previewing 
 Exporting Drawings-Exporting to Graphic Formats, Copy and Pasting Into Other Applications 
 Using Styles and Templates-About Styles and Templates, Creating a Style, Applying a Style, 

Copying Properties 
 Using Corel Trace- Types of Graphic Formats, About Corel Trace, Tracing Images, Importing Traced 

Files into CorelDraw, Special Trace Effects 
 Using Corel R.A.V.E.- About Corel RAVE, Playing sample RAVE animations, Performing the five 

steps necessary to create RAVE animations, Working with the Timeline Docker, Tweening objects to 
create animation, Exporting to Macromedia Flash format, Publishing to the web Create web rollovers, 
Inserting hyperlinks, Creating sprites and adding behaviors, Creating interactive movies 
 

 

 

 

 

 

 

 



Module Code: A04- 04 
Module Name: Networking and Communication Technology 

Topics- Networking Basics, Installing & Configuring the Network with Windows 2008     
                                                                                                                           Theory- 60 

                                                                                                                                 
Practical-- 40     

 
CONCEPTS OF NETWORKING        
Methods of Data Communication: Data Communication, Communication Channels, (Twisted Pair 
wire, Radiowaves, Microwaves, Optical fibres) Digital Vs Analog Data Transmission, Serial Vs 
Parallel data transmission. 
Communication Protocols: Synchronous Vs Asynchronous Data transmission, Baud, bandwidth, 
Simplex, Half-duplex, Duplex data Communication, IPX, TCP/IP. 
Modems & Multiplexers & Front-end processing Networking: LAN's & WAN's incentive for 
installing LAN's. TOPOLOGIES, Star, Ring, Bus (Ethernet), Hybrid. 
Novell Netware: Users, Groups Printers 
Novell Concepts: Installing Server 
Installation Overview: Installing Workstation, Setting up users, Shared Printer installation 
Wan's & Electronic Mail Distributed Data Processing (DDP) Review 

COMPUTER NETWORKS & COMMUNICATION TECHNOLOGY 

Introduction to Computer Networking: What is networking, Computing models (Centralized 
computing, distributed computing, collaborative computing), types of computer networks (LAN, MAN, 
enterprise & global WAN), Networking elements (Network services, Networking Media & Protocols), 
Peer to Peer & Server centric networks. 
Network Services: Common network services, File services, Print services, Message services, 
directory services, application services, database services, centralized vs distributed network 
services, Network operating systems, Centralized vs distributed file services. 
Transmission Media: Common computer network transmission media, cable media, twisted pair 
cable, coaxial cable, fibre optic cable, discussing the cable media w.r.t parameters ( cost, ease of 
installation, capacity, attenuation, EMI), benefits & consideration for using different cable media,  
Wireless media (radio waves, microwaves, infrared), discussing the wireless media w.r.t parameters 
(frequency range, cost, ease of installation, capacity, attenuation, EMI), benefits & consideration for 
using different wireless media. 
Network Connectivity Hardware: Transmission media connectors, network interface boards, 
Modems, Repeaters, Hubs (active hub, passive hub, intelligent hub), Bridges, Multiplexers, Routers. 
OSI Physical Layer:  Need for communication rules, Models & layers, OSI Model & Layers,  Physical 
layer, point to point & multipoint connections, Physical topologies (Bus, star, ring, mesh & cellular), 
Digital signaling (Current state & state transition methods), Asynchronous & Synchronous bit 
synchronization, Broadband & baseband  bandwidth, Multiplexing (FDM, TDM & STDM) 
OSI Data Link Layer: Purpose of data link layer, Logical topology (Bus, ring, Media access methods 
(contentions, token passing & polling), Physical device addressing, Transmission synchronization 
(asynchronous, synchronous, isochronous), Flow control (static window & dynamic window) & error 
control. 
OSI Network Layer: Logical network address, service address, switching (circuit switching, message 
switching, packet switching, datagram packet switching, virtual circuit packet switching), Route 



discovery methods (distance vector & link state), Route selection (static & dynamic), Connection 
services (unacknowledged connectionless, connection oriented, acknowledged connectionless),  
Error control , Packet sequence control, Gateway services. 
OSI Transport Layer: Functions of transport layer, address/name resolution, addressing (connection 
identifier & transaction identifier methods), segment development, segment sequencing, error control 
& end-to-end flow control. 
OSI Presentation Layer: Functions of presentation layer, Translation types (Bit order byte order, 
character code, file syntax), Public key & private key encryption. 
OSI Application layer: Functions of transport layer, Network services, Service advertisement (active 
& passive), Service using methods (OS call interception, remote operation, collaborative). 
DATA COMMUNICATIONS: Multiplexing, Signaling, Encoding & Decoding, Error Detection & 
Recovery, Flow Control, Sliding Window, Congestion Management. 
COMMUNICATION NETWORKS: Introduction to networking, OSI Model for Networking, Internet, 
ATM, Network Components (Cables, Hubs, Bridges, Switches, Routers), Network Topologies, Shared 
Medium, Peer to Peer, Hybrid Technology. 
NETWORK TECHNOLOGIES:  Local Area Network Technologies, Ethernet Technologies, Ethernet 
Versions, Token Ring Technologies, Wide Area Network Technologies (Frame Relay, SMDS, ISDN, 
SONET, PPP, HDLC, LLC), Wireless Networks (Radio Frequencies, Microwave Frequencies, Infrared 
Waves. 
MULTIPLE ACCESS : Design Issues, Distributed & Centralized Design, Circuit Mode & Packet Mode 
Design, Implementation Issues, Performance Considerations,  Base Technology (FDMA, TDMA, 
CDMA, Centralized Access, Circuit Mode Access, Poling or Packet Mode Access, Reservation Based 
Access), Distributed Access (decentralized polling, CSMA, CSMA/CA, CSMA/CD, Busy Tone Multiple 
Access & Multiple Acccess Collision Avoidance, Token Passing, ALOHA, Slotted ALOHA, 
Reservation ALOHA), Hardware Addressing 
SWITCHING : Circuit Switching (Time Division switching, Space division switching, time space 
switching, time space time switching),  Packet Switching (Port Mappers, Blocking, ATM Switching, 
Switching Fabric (Crossbar, Broadcast, Switching Fabric Elements), Bridges (Transparent bridges, 
Spanning Tree Algorithm, Virtual LANS), Switches. 
NAMING & ADDRESSING:  Hierarchical Naming, Addressing, Telephone Networks, Internet, IPv4, 
Subnetting Ipv4 Networks, Private Networks, Asynchronous Transfer Mode, Name Resolution, 
Address Resolution Protocol (Arp), RARP 
ROUTING: Routing Information, Routing Protocols, Hierarchical Routing, Multicast Routing. 
SERVICES & APPLICATIONS: File transfer protocol, TFTP, Domain Name System, DHCP, SNMP, 
Electronic Mail, WWW, HTML, HTTP, RPC & Middleware. 
SECURITY: Threats, Encryption/Decryption, Firewalls, IP Security, Web Security, E-Mail Security. 
DATA COMMUNICATION AND NETWORK 
Data Communication, Communication channels (Twisted pair wire, Radiowaves, Microwaves, Optical 
fibres) Digital Vs Analog Data transmission, Serial Vs Parallel data transmission, Synchronous Vs 
Asynchronous Data transmission, Baud, bandwidth, Simplex, Half-duplex, Duplex data 
Communication, IPX, TCP/IP Data Modems: Concept of  modulation, Amplitude shift keying, 
Frequency shift keying, Phase shift keying, Quadrature PSK, Differential PSK, Multichannel Data 
Communication : Circuits, channels, and concept of multichanneling, PCM, Frequency division 
multiplexing, Time division multiplexing, CODECS, Data Networks : Circuit switching, Packet 
switching, PABX, Network topologies, Network Protocols : OSI model, Data link protocols, Local 
networks: Ethernet and token rings, X.25 protocol, Satellite networks, ISDN, Fibre Optic 
Communication : Optical source, Propagation in fibre, Light detector, FDDI-fibre distributed data 



interface, Data Communication Systems :Fascimile (FAX), Satellite Communication, Digital 
telephony. 
WINDOWS 2008 
Installing Windows Server 2008, What Is Server Core, Hardware compatibility, Partitioning hard-disk 
drives, Performing a Server Core install, Installing from the network , Configuring Windows Server 
2008,. TCP/IP on Windows Server 2008, TCP/IP Basics (IPv4), IP addressing, Subnetting, Obtaining 
IP addresses,   
Gateways and routing , Dynamic Host Configuration Protocol (DHCP), Setting Up TCP/IP, 
Configuring TCP/IP, Understanding and Using IPv6 , Troubleshooting TCP/IP , Installing  and 
configuring SNMP,  Windows Firewall Configuration and Management, : Routing and Remote 
Access, Backup and Restore 
 
Managing Users and  groups -The Windows Server 2008 Account, users, Local users , group, 
Exploring the Users and Computers management tools , Windows Server 2008 user accounts, 
Account policy,  Security principals and the logon authentication process , Security identifiers, SAM 
and LSA authentication, User Accounts in Action, Naming user accounts,  Passwords, Understanding 
logon,  Granting remote access ,Creating a user account ,Renaming user accounts, Deleting and 
disabling user accounts ,Copying accounts ,Group Accounts, Nesting groups, Rights and 
permissions, Delegating responsibility, Installing and Setting Up Printers, storage management, 
Primary partitions Extended partitions,  Basic volumes . 

  



 
Module Code: A04- 05 
Module Name: MySQL 

Topics- RDBMS using MySQL                                                  Theory- 45 
                                                                                                     Practical-55 
          Total - 100 
 
Overview of DBMS  
An Overview of DBMS and DB Systems Architecture: Introduction to Database Management 
systems; Data Models; Database System Architecture; Relational Database Management systems; 
Candidate Key and Primary Key in a Relation; Foreign Keys; Relational Operators; Set Operations on 
Relations; Attribute domains and their Implementation, 12 Codd's rules for RDBMS. Characteristics of 
Relational DBMS 
The Normalization Process: Introduction; first Normal Form; data Anomalies in INF Relations; 
Partial Dependencies; Second Normal Form; data Anomalies in 2NF Relations; Transitive 
Dependencies; Third Normal Form; data Anomalies in 3NF Relations; 
The Entity Relation Ship Model: The Entity Relationship Model; Entities and Attributes; 
Relationships; One-One Relationships; Many-to-one Relationships; Normalizing the Model; Table 
instance charts. 
MySQL 
Introduction MySQL-Elements of MySQL and Its Environment, Installation Choices and Platforms, 
Using the Command-Line Interface, Using a Text Editor 
Using the MySQL monitor-Starting the Monitor, The Monitor Help, Running the Monitor in Batch 
Mode, Loading the Sample Databases, Style, Case, and Semicolon, MySQL Monitor Program 
Options  
Creating and Using a Database, Creating and Selecting a Database, Creating a Table, 
Loading Data into a Table, Retrieving Information from a Table, Selecting All Data, Selecting 
Particular Rows, Selecting Particular Columns, Sorting Rows, Date Calculations, Working with NULL 
Values, Pattern Matching, Counting Rows Using More Than one Table. 
Basic SQL- The SELECT Statement and Basic Querying Techniques ,The INSERT Statement ,The 
DELETE Statement ,The UPDATE Statement ,Exploring Databases and Tables with SHOW and 
mysqlshow 
Advanced Querying -Aliases ,Aggregating Data ,Advanced Joins ,Nested Queries, User Variables, 
Transactions and Locking ,Table Types  
Doing More with MySQL- . Inserting Data Using Queries ,Loading Data from Comma-Delimited Files 
,Writing Data into Comma-Delimited Files ,Creating Tables with Queries Updates and Deletes with 
Multiple Tables ,Replacing Data ,The EXPLAIN Statement 
Managing Users and Privileges- Understanding Users and Privileges ,Creating and Using New 
Users ,Privileges ,The GRANT OPTION Privilege ,How Privileges Interact ,Users and Hosts 
,Checking Privileges ,Revoking Privileges ,Removing Users ,Understanding and Changing 
Passwords ,The Default Users ,Resetting Forgotten MySQL Passwords 
Backups and Recovery -Dumping a Database as SQL Statements ,Loading Data from an SQL 
Dump File ,mysqlhotcopy ,Scheduling Backups ,The Binary Log ,Checking and Repairing Corrupted 
Tables ,Re-Creating Damaged Grant Tables, Structure of the Options File. 
  



Module Code : A04- 06 
Module Name : Application Programming  
Topics- Programming with C#.NET                                            Theory-40 

                                                                                                  Practical-60 
                                                                                                                                                                 Total-100 
 
C#.NET 

 Overview of C#  -  Evolution of C#, features of c#, Benefits of changing over to c#,Differences 
between C++ and C# 

 .NET Framework and platform - Overview of the .NET platform,.NET components,.NET framework-
Common language Runtime, Unified programming Classes, Active server pages. NET, Assemblies-
Private and shared 

 Introduction to C# - General structure of a C# program, The main method, Name space declaration, 
Interactive Input/Output, Arguments in main method, command line arguments, runtime arguments 

 C# Basics - Value types, default constructors, struct types, Struct modifiers, Struct interfaces, 
enumeration types, Enum modifiers, reference types, class types, object type, string type, interface 
types, delegate types, ,Boxing and unboxing, array types, variables and parameters, Operands, 
Statements, expressions, operators, Directives 

 Classes - C# classes, Objects, creating classes, using an object’s member functions, Static Methods 
and new operator, creating an object, different types of  class members 
,inheritance,Accessspecifiers(Private,Public,Protected,package),cleaning up unused objects, garbage 
collector, class library 

 Methods – Structure of a method, Method overloading, implementing methods, Exception 
handling,Try and Catch 

 Statements – Selection statements, Switch statement, Loops, jump statement, Break, continue, 
Goto, return statement 

 Abstract and Base classes – Abstract modifier, abstract classes, virtual methods, base classes, 
introduction to .NET base classes. For each statement 

 Arrays and Strings – Array types based on dimensions, passing arrays as parameter, declaring 
array, initializing array, creating array arrays as objects, System. Array type, Array members, array 
Covariance, array list, out and ref, String operations, converting objects to strings, String Builder, 
String formatting in .NET 

 Attributes-Attributes, creating custom attributes, attribute parameters, Reflecting on attributes, 
Interfaces, Delegates, Delegate types, Delegate Instantiation, Multicast Delegates, Delegates vs 
Interfaces ,Namespaces, Types of namespaces, Assemblies, versioning, uses of versioning 

 File handling – File and Folder operations, listing files in a folder, copying and deleting files, 
reading/writing text files and binary files 

 Exceptions and error handling in C#- Common exception classes, statements(Try, Catch, Throw, 
Checked and Unchecked, Lock, Using, ), Hierchical Structure of Exception, Passing Exception to 
Caller, user defined exception class, Types of Exception handlers, The Exception object, Error 
handling using Exceptions 

 Data handling in C#-ADO, Introduction to Data Access with ADO.NET, Components of ADO.NET, 
Connecting to database, Accessing data with ADO. NET, Programming architecture, Dataset 
Namespace, Connecting objects, Table Mappings, Databases, Accessing data with ADO.NET, 
Connecting to databases, Building .NET Applications, Security permissions in C#, Printing in C# 
  



 
 
Module Code: A04- 07 
Module Name: Web Application Development using Java Programming (Server Side Scripting) 
Topics- Basics of OOPs concepts & C++, Core Java programming using J2EE Framework, Java 

Applets & Swings, JDBC, Java Servlets, Java Beans, Introduction to JSP, EJB 
Theory-40 

Practical-60 
                                                                                            Total-100 

 
OBJECT ORIENTED PROGRAMMING SYSTEM (OOP's) 
OOPS: What is oops, Need, Scope of oops. 
Basics: Basic Building Blocks Object, Message, Methods Concept of Class, Properties of Class and 
advantages of using Classes. 
Encapsulation and Inheritance: Encapsulation, Abstraction and Information hiding Inheritance, Sub 
classes and Super Classes, abstract classes, Multiple inheritance. 
OOPS Concepts: Modularity, Typing, Persisting, Concurrency, Polymorphism. 
Language Supporting OOPS Concepts: C++, JAVA 
Programming Using C++ 
Introduction to object oriented programming, characteristics of object programming languages. 
Overview of C++: Characters and string literals, variables, objects and their declarations, operators. 
Principles of Object-Oriented Programming: Software Crisis; Software Evolution; A Look at 
Procedure-Oriented Programming; Object Oriented Programming Paradigm; Basic Concepts of 
Object-Oriented Programming; Benefits of OOP; Object Oriented Languages; Applications of OOP. 
Beginning with  C++: What is C++?, Applications of C++, Character and string literals, object and 
their declarations, operators, A Simple C++ Program, More C++ Statements, An Example with Class;  
Structure of C++ Program, Creating the  Source File, Compiling and Linking.   
Tokens, Expressions and Control Structures: Introduction; Tokens; Keywords; Identifiers; Basic 
Data Types; User-Defined Data  Types; Derived Data Types; Symbolic Constants; Type 
Compatibility; Declaration of Variables; Dynamic Initialization of Variables; Reference Variables; 
Operators in C++; Scope Resolution Operator; Member Dereferencing Operators; Memory 
Management Operators; Manipulators; Type Case Operator; Expressions and Implicit Conversions; 
Operator  Overloading; Operator Precedence; Control Structures. 
Functions in C++: Introduction; The Main Function; Function Prototyping; Call by Reference; Inline 
Functions; Default Arguments; const Arguments; Function Overloading; Friend and Virtual Functions. 
Statements: Simple statements, conditional statements, compound conditions, book lean, 
expressions, nested conditions, switch statements, Type Conversion. 
Loops and Iterations: While statement, do... while, for, break, continue. 
Functions: Library functions, user defined functions, declaration and definitions, local variables and 
functions, function types, passing by reference, passing by constant reference, scope of functions, 
overloading. 
Overloading: Overloading the assignment operator, arithmetic operator, relational operators, and 
increment and decrement operators, conversion operators. String classes, composition and 



inheritance, stream I/O templates.Elements of Visual C++, working with forms, communicating with 
other applications, class libraries. 
Arrays: Defining arrays, array elements, initializing and processing arrays, passing arrays to 
functions, sorting and searching arrays, type definitions, multidimensional arrays. 
Pointers and References: Introduction to pointers and references, objects and values, returning a 
reference, array and pointers, new and delete operators, pointers to pointers and functions. 
Classes and Objects: Introduction; C Structures Revisited; Specifying a Class; Defining Member 
Functions; A C++ Program with Class; Making an Outside Function Inline; Nesting of Member 
Functions; Private Member Functions; Arrays Within a Class; Memory Allocation for Objects; Static 
Data Members; Static Member Functions; Arrays of Objects; Objects as Function Arguments; 
Friendly Functions; Returning Objects; const Member Functions; Pointers to Members. 
Constructors and Destructors: Introduction; Constructors; Parameterized  Constructors; Multiple 
Constructors in a Class; Constructors with Default Arguments; Dynamic Initialization of Objects; Copy 
Constructor; Dynamic Constructors; Constructing Two-Dimensional Arrays; Destructors. 
Operator Overloading and Type Conversions: Introduction; Defining Operator Overloading; 
Overloading Unary Operators; Overloading Binary  Operators; Overloading Binary Operators Using 
Friends; Manipulation of Strings Using Operators; Rules for Overloading Operators; Type 
Conversions. 
Inheritance: Extending Classes: Introduction; Defining Derived Classes; Single Inheritance; Making 
a Private Member Inheritable; Multilevel Inheritance; Multiple Inheritance; Hierarchical Inheritance; 
Hybrid Inheritance; Virtual Base Classes; Abstract Classes; Constructors in Derived Classes; 
Member Classes: Nesting of Classes. 
Pointers and References, Virtual Functions and Polymorphism: Introduction to pointers and 
references; Pointers to Objects; objects and values, returning a reference, array and pointers, new 
and delete operators, pointers to pointers and functions, this Pointer; Pointers to Derived Classes; 
Virtual Functions; Pure Virtual Functions. 
Strings: Strings, string I/O arrays of strings, string related library functions. 
Classes: Introduction, class declaration, constructors, access functions, copy constructor, class 
destructor. 
Managing Console I/O Operations: Introduction; C++ Streams; C++ Stream Classes; Unformatted 
I/O Operations; Formatted Console I/O Operations; Managing Output with Manipulators. 
Working with Files: Introduction; Classes for File Stream Operations; Opening and Closing a File; 
Detecting End-of-File; More About Open(): File Modes; File Pointers and Their Manipulations; 
Sequential Input and Output Operations; Updating a File: Random Access; Error Handling During File 
Operations; Command-Line Arguments. 
Object-Oriented Systems Development: Introduction; Procedure-Oriented Paradigms; Procedure-
Oriented Development Tools; Object-Oriented Paradigm; Object-Oriented Notations and Graphs; 
Steps in Object-Oriented Analysis; Steps in Object-Oriented Design; Implementation; Prototyping 
Paradigm; Wrapping Up. 
JAVA  
Fundamentals of JAVA: Computer Basics, Simple Java Programming Language, Complex Java 
Programming Language, Flow Controls -if and while constructs do & for loops, switch break & 
continue statements, Oops.  
Java Programming: Java Key Features, JVM Garbage Collection Security, Classes, Packages, Java 
API, Java Keywords Types and Arrays, Primitive Types Identifiers Ref. Variable, Objects Types 
Identifiers Ref. variable, Objects and Classes - Encapsulation, Polymorphism, Inheritance 
Constructors, Heterogeneous Collections, Advanced language features of JAVA, Overloading, 



Overriding, Abstraction, Inner classes, Wrapper classes, collection classes, Exceptions - Definitions, 
Handling Exceptions, Identifying common exceptions, JAVA GUI, AWT Package AWT Event 
Handling, Adapter Classes Layout Managers, Java Foundation Classes-Key features of JFC, Swing, 
JFrame, JApplet, Java Applets, Threads, Stream I/O and Files, Networking with JAVA. 
ADVANCE JAVA PROGRAMMING  
JDBC: Introduction to JDBC, JDBC Drivers Type, Connection, JDBC URLs, Driver Manager, 
Statement-Creating Executing Closing, Result Set-Data Types and Conversions, Prepared 
Statement, Caliable Statement, Mapping SQL and Java Types, JDBC-ODBC Bridge Driver.  
RMI: Distributed Applications, Introduction to RMI, Writing an RMI Server, Designing a Remote 
Interface, Implementing a Remote; Interface, Creating a Client Program, Compiling the Example 
Programs, Running the Example Programs. 
Corba: Distributed Applications, CORBA-An Introduction, The OMG, CORBA Architecture, CORBA 
Services, CORBA Products, JAVA IDL. 
Servlets: Movement to Server Side JAVA, Overview of Servlets, Common Gateway Interface (CGI), 
The JAVA Servlet Architecture, Generic Servlet and HTTP Servlet, The Servlet Interface, Requests 
and Responses, The Life Cycle of a Servlet, Retrieving Form Data in a Servlet, Session Tracking 
Cookies. 
Java Beans: Java Beans Concepts and the Beans Development Kit. Using the Bean Box, Writing a 
Simple Bean Properties, Manipulating Events in the Bean Box, The Bean info interface, Bean 
customization, Bean Persistence. 
Enterprise Java Beans (EJB): Introduction, Architecture of EJB, EJB Servers, Containers, EJB 
Implementation, Remote Interface of Bean, EJB Session Beans, Transactions and EJB, EJB 
Deployment, Writing EJB Clients. 
Java Server Pages (JSP): Compare and Contrast JSP with CGI and Servlet Technologies, Develop 
a basic Java Server Pages, Deploy Java Servlet Pages, List JSP directives, Integrate JSP with Java 
Beans Components, Handle JSP exceptions, Compare two-tier and multi-tier web application 
architectures. 
 
 

 

 

 
 
 

 

 


